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CST Cerner CST Cerner Help Topic Template Assistance
This document is a guide for using the CST Cerner Help Template for when you are developing or updating. Before using this Assistant, you may want to review the following documents: 
· For more detailed information on using Word and Snagit, refer to the Writing Learning Materials document found on Confluence.
· The CST Learning Team Style Guide provides the writing and style expectations for all written CST Learning Team documents and presentations and covers such topics as tone, audience, tense, voicing, grammar, and acronyms. 
	TO BEGIN
	

	[bookmark: _GoBack]Download the most updated CST Cerner Help Template from CST Cerner Help Request Changes topic. 
	The template is located 
It will be in Microsoft Word (.dotx) template format. 

	Open the template file
	Download and open the template

	Save the file as a Word document (.docx) using Save As.
	Save the Word document with the name of the proposed title for the topic.



Preparing Your Screen
You now have the template from which to develop your CST Cerner Help topic. It is helpful to set up your screen in Word.
	View Style Pane
	

	What are Styles?
In Microsoft Word, styles are a collection of pre-set formatting for different elements of the document. This saves time because you do not have to set each element manually. In addition, consistency makes the document easier to read and is more visually pleasing.
The template has formatting and standardized Styles built in. 
The Style Pane provides a list of the styles used in the document.

1. Click on the Home tab.
1. Click on the Styles Dialogue Launcher icon. It is the diagonal arrow in the bottom right corner of the Change Styles button.
[image: ]

The Styles Pane will open. This is a list of all the style elements needed for the Workbook.
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML94f114.PNG]Style Pane


	Quick Styles
You may notice that the Styles are displayed in visual format on the Home tab.
If you hover over the image, it will temporarily display the text adjacent to your cursor on the page so you can see what the Style will look like. You can do the same by selecting the Style from the Styles window.
If you click on the More button, you can see all of the Styles on the Home tab. 
[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML633fe99.PNG]
	
[image: ]


[image: ]

	[image: ]
	NOTE: Do NOT Modify any of the features of the Styles. These styles will make your work easier and serve to maintain a consistent look for all workbooks.



	Show Non-Printing Characters
	

	The Show/Hide button can be toggled on to show the non-printing characters such as tab spaces, paragraphs and line breaks.
Non-printing characters are especially valuable when troubleshooting in Word.
1. Chick the Show/Hide button [image: ]in the Paragraph group on the Home tab.
Typical Non-Printing Characters
Paragraph Marker: [image: ]
Line Break: [image: ] 
Tab: [image: ]
Space: There is a dot between each word where the space key was pressed.
	
[image: ]

[image: ]


[bookmark: _Toc7001906]Images and Screenshots
Screen shots should be as readable as possible. See the CST Writing Learning Materials for detailed instructions on capturing good quality screenshots and using Snagit. Resize the window BEFORE you grab the screen shot.
	[bookmark: _Toc7001907]Inline Images 
When advising user to click on an iconic button, use both an image of the button and use the correct name of the button or icon to conform with guides for visual impairment. Look up the correct names.
	
Eg. Click Orders for Signature [image: ] button to review and sign the order.

	[bookmark: _Toc7001908]Capture Larger Screenshots 
Use Snagit to capture screenshots.
Use monitor with the highest screen resolution, full monitors rather than laptops. This maximizes visibility.
Resize window, column width to maximize visibility and reduc white space.
Crop the screenshot in Snagit, not in the Word document. This will prevent the image from being resize when imported to CST Cerner Help.
Resize as necessary in Word. 
If you need to save the image, save as PNG - Word templates automatically use this setting.
Do not format images and screenshots (e.g. no boarders, drop shadows).
Do not use screen shots that include any kind of trademark names, cartoon names or other inappropriate context.
Do not use screenshots of real patient data or test patient data that may be disrespectful.
	Before Example:
[image: ]
After Example  :
[image: ]


Copy and Paste from Another Document
When copying and pasting from another document that uses a different Word styles make sure you do not copy over the other document’s styles: 
	1. Copy the text. 
2. Format the paragraph where you want to paste the content.
3. Right-click where you want to paste the copied content. 
4. Always choose Keep Text Only in the Paste Option to avoid altering and adding unnecessary styles (found on page 16).
	

[image: ]


Types of Help Topics
There are three kinds of topics:
	Type of Help Topic
	Description

	Step by Step instructions
	These make up the majority of the content.
Basically these are the “How to” instructions.

	Definitions or overviews 
	Brief information, such as describing a View or screen or an overview of definitions. 
They do NOT typically contain step by step instructions

	Processes or workflows
	When the process involves more than one role it is recommended you:
Create an outline of the steps, identifying the role in brackets
Create separate topics for the steps for each role or phase in the process. That way, the user can navigate to the content they need, when they need it.
When the workflow involves one person and multiple major steps or directions to use different applications make sure the content uses descriptive Subheadings, starting with an imperative verb


Step By Step Instruction Topics 
Ideally Step by Step topics should be 2 – 3 Word pages. 
Step by Step topics should not be more than 5 Word pages. 
	Step By Step Topic Title and Headings
	

	Title - Top Heading
Use Heading 2
Start with an imperative verb, e.g. Create, Modify, Place order, followed by the function and sometimes the application
Think about how the user can select the correct topic when they Search for a topic. Sometimes the audience or application is in brackets. e.g. (Pharmacy), (Providers), (ED Nurses), (LGH)

	Subheadings
Use Heading 3
Chunk content into major steps  and use subheadings
Subheading start with a verb (imperative), followed by the function

	Additional Optional Headings
Breaks up long activities which can help learner know where they are and transition to the next step. For example an activity may involve: Heading 4 milestones such as: Search for the Order, Complete the Oder Details, and Initiate the Order. In this example the learner creates the Transfer Ticket and then Prints the Transfer Ticket.
	[image: ]Style: Step1Number
for numbered list items
Style: Heading 4 




Step By Step Instructions
	Step by Step Lists
	

	· Be concise but descriptive. Avoid words like “on the”, e.g. “Click Save button”, rather than “Click on the Save button”.
· Break down the instruction so each action is a new step. Each action should be a separate step (number). This will help ensure the learner does not miss a step.
· Start with the action word to help the learner know what the step involves. 
· Bold the part of the screen they will act on. This helps them locate and learn the part of the screen.
· Use imperative verbs at the beginning of the instruction, e.g. Select, Click, Start, Review, Open. 
· Use present tense e.g. “the Search window opens” or something “displays.”
· Steps should be sentences with periods.
· Bulleted lists should have periods if they are sentences but contain no periods if the list items are sentence fragments.

	Formatting
· Don’t use Bullets, Numbering, Multilevel List, Decrease Indent, or Increase Indent buttons at the top. Always apply the style paragraph by paragraph by clicking the style name in the list.
	[image: C:\Users\MMOVAH~1\AppData\Local\Temp\SNAGHTML1a2f6f7d.PNG]

	Include an introductory paragraph at the beginning to give the topic some context.
When creating step by step instructions:
· For each paragraph choose the appropriate Step style. 
· 
· To apply this style to the paragraph, the cursor needs to be somewhere on paragraph, then click on font style name in the list.
Lists and Images
· The numbers in the image correspond with the step by step instructions.
· Use Snagit to add numbers (or letters), boxes and arrows as needed.
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML4979a3.PNG]Style: Step1Numbers 
for step by step instructions. There are other step by step combinations that are explained below.
Style: Body Text 


	In this image the Show/Hide button is toggled on to show the non-printing characters such as tab spaces, enters (paragraphs) and line breaks.
· Use Shift + Enter to create a line break within a paragraph. This will line up images and additional lines of text that fall under a specific step.



Results Text
In this example the result of completing steps 3 is that the Order Information window opens. 
· The result of an action can include an image, text or both. 
· The result sentence should be part of step 3, NOT the beginning of step 4. Here we see it in on a separate line. Once again, this helps to prevent the learner from missing a step that is buried in a paragraph. 
	[image: ]The result of the step is NOT another step. It should not be numbered. IT is also lined up with the text in step 3.
Line Breaks created by pressing Shift + Enter. 
Notice how the image aligns with the text in step 3. 
Line Breaks created by pressing Shift + Enter. 
Notice how the image aligns with the text in step 3. 


	[bookmark: _Ref9337358]Restart Numbering
There may be times when format a Step list style and the numbers continue from a previous list. You can restart the list at 1 or a.
1. Right-click on the first number that is not correct.
1. Choose Restart at 1. When you are in an alphabetical list, the option will say Restart at a or A.
· The remaining numbers should automatically renumber themselves as long as you used the correct style.
· Alternatively, you can choose Continue Numbering if a list is restarting when it should be a continuation of a list. 
	

[image: ]



Other Types of Lists
	Lists Combining Step1Number with Step2Bullet 
In this example the sub steps are listed with bullets. Step2 indicates the sub steps are indented under the numbered items (Step1). 
Using this combination can 
Help the learner to identify the main steps
Each sub step can typically be done in any order
If you add a screen shot you would not be able to annotate the bulleted list but as we see here, the image that follows, displays the results.
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML9b27c.PNG]Style: Step1Number
for numbered list items
Style: Step2Bullet 
for bulleted list items


	Combining Steps with Ordered Sub Steps
In this example the sub steps are listed with a lowercase letters. Step2 indicates the sub steps are indented under the numbered items (Step1). 
Using this combination can :
help the learner to identify the main steps
list the sub steps in a particular order
An image can be annotated with the lowercase letters in red circles, to identify where the learner needs to click for a given set of sub steps.
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML71ef4.PNG]Style: Step1Number
for numbered list items
Style: Step2Letter 
for list items with a, b, c etc.


	[bookmark: _Ref9506342]Lists and Annotated Screenshots
Use red circles with numbers to annotate the image. Be sure to do this in Snagit, not Word.
The numbered steps should align with the numbers in the red circles.
Be sure not to put too many steps on one screenshot as it could be hard to read. In this example there are two screen shots of different screens.
	[image: ]



Tables
Note, Warning and Legend Tables
	NOTE Tables
	

	NOTE tables can be used to provide:
· additional information (e.g. something that happens downstream)
· information about an exception 
· an alternative method  
· a valuable tip
Be sure to keep these points in mind. 
It is best to copy and paste to create additional NOTE tables. This will maintain the table formatting. See page 12.
Be strategic when determining where to placing NOTE tables.  The learner needs to go through the “happy” path before learning all about the exceptions, troubleshooting tips. 
Avoid placing the box in the middle of set of steps that go together, e.g. a few steps that go with a screenshot.
If a NOTE table contains more than a few paragraphs or points, it might be better to create a new heading and section to detail the exception or troubleshooting tip. You can refer to the heading in the step by step instructions. 
	


Example of Note Tables
[image: ]

[image: ]



	WARNING Tables
	

	A WARNING table is a good way to bring the  learner’s attention of some information that can cause problems such as:
Critical clinical information
Critical information that the system requires
Include a brief rational of why the issue is important.
It is best to copy and paste additional WARNING boxes to maintain the formatting. See page 12. 
	Examples of Warning Tables
[image: ]
[image: ]


[bookmark: _Ref9331922]Copy a Table
	Copy a Table
	

	1. Hover your mouse over the table. You will see a table handle appear in the top left corner. [image: ]
1. Click the Table handle. [image: ] This selects all of the table.
1. Click Copy. [image: ]
1. Move your cursor to the line where you want to copy paste the table. 
1. Click Paste. [image: ]

	


[image: ]


Legends
	Screen Overviews (Parts of a Screen with a Legend Table)
	

	Some Activities provide an overview of the functionality in a screen. This provides the learner with knowledge before the learner completes step by step instructions in CST Cerner.
Annotate the image with uppercase letters in red squares. Try not to cover up other parts of the screen.
Include a Legend table:
1. Copy and paste the legend table in the template. .  See page 12. 
1. You may need to Restart the lettering (covered on page 8).
OR
1. Create a 2 column table. It should use the default table design style CST Table.
5. Resize the first column.
6. Merge the cells in the top row and add the word LEGEND with Table Heading style.
7. Apply the LegendLetter style to the fist column.
8. Add definitions or description to the second column.

	[image: ]Style: LegendLetter
for uppercase letters in the first column
Style: TableHeading



[bookmark: _Toc6216678][bookmark: _Toc9848158]Table Design
Some templates have a default Design applied to a new table. Designs are available on the Design tab. Cell Shading and Borders can also be set from the Table Properties window.
The CST Table design is the default design for many templates.

	Table Heading
	Table Heading
	Table Heading

	Table Text
	Table Text
	Table Text

	Table Text
	Table Text
	Table Text



	1. Click anywhere on the table.
1. Select Design tab under Table Tools.


1. 
Hover to make sure you have located the correct Design; CST Table for tables with green heading rows or PaddedTable for Note and Warning tables. 
Click to apply the Design.


You can turn off the shading for the header row by deselecting Header Row check box on the Table Style Options.
	[image: ]   
[image: ]

[image: ]



Related Information at the End of the Topic
Add the following at the end of each topic.
Related Topics
List related topics in CST Cerner Help (use BodyBullet1)
Related Positions
Please list all related positions. Be specific as this helps use determine which navigation pages requires links to the topic 
(use BodyBullet1)
Key Words
Key words to assist in search function. There is no need to repeat words in the title of the topic. (use BodyBullet1)
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